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Legal Information 

INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH INTEL PRODUCTS. NO LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE, 
TO ANY INTELLECTUAL PROPERTY RIGHTS IS GRANTED BY THIS DOCUMENT. EXCEPT AS PROVIDED IN INTEL'S TERMS AND CONDITIONS OF SALE FOR SUCH 
PRODUCTS, INTEL ASSUMES NO LIABILITY WHATSOEVER AND INTEL DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE AND/OR USE OF 
INTEL PRODUCTS INCLUDING LIABILITY OR WARRANTIES RELATING TO FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY, OR INFRINGEMENT OF ANY 
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A "Mission Critical Application" is any application in which failure of the Intel Product could result, directly or indirectly, in personal injury or death. SHOULD YOU 
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features or instructions marked "reserved" or "undefined". Intel reserves these for future definition and shall have no responsibility whatsoever for conflicts or 
incompatibilities arising from future changes to them. The information here is subject to change without notice. Do not finalize a design with this information.  

The products described in this document may contain design defects or errors known as errata which may cause the product to deviate from published 
specifications. Current characterized errata are available on request. Contact your local Intel sales office or your distributor to obtain the latest specifications and 
before placing your product order. Copies of documents which have an order number and are referenced in this document, or other Intel literature, may be 
obtained by calling 1-800-548-4725, or go to: http://www.intel.com/design/literature.htm  

Intel processor numbers are not a measure of performance. Processor numbers differentiate features within each processor family, not across different processor 
families. Go to: http://www.intel.com/products/processor_number/  

Software and workloads used in performance tests may have been optimized for performance only on Intel microprocessors. Performance tests, such as SYSmark 
and MobileMark, are measured using specific computer systems, components, software, operations and functions. Any change to any of those factors may cause 
the results to vary. You should consult other information and performance tests to assist you in fully evaluating your contemplated purchases, including the 
performance of that product when combined with other products.  

Intel, the Intel logo, Intel Atom, Intel Core, Intel Inside, Intel Xeon Phi,  and VTune are trademarks of Intel Corporation in the U.S. and/or other countries.  

*Other names and brands may be claimed as the property of others.  
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1 About this Document 
This document describes the Intel® SoC Watch for Android tool. Note that SoC Watch is also a 
component within the Intel Energy Profiler tool. 

1.1 Intended Audience 
You should read this document if you are a SoC Watch user. 

1.2 Conventions and Symbols 
The following conventions are used in this document. 

Table 1  Conventions and Symbols used in this Document 

This type 
style 

Indicates an element of syntax, reserved word, keyword, filename, computer output, or part 
of a program example. The text appears in lowercase unless uppercase is significant. 

This type style Indicates the exact characters you type as input. Also used to highlight the elements of a 
graphical user interface such as buttons and menu names. 

This type 
style 

Indicates a placeholder for an identifier, an expression, a string, a symbol, or a value. 
Substitute one of these items for the placeholder. 

[ items ] 

 

Indicates that the items enclosed in brackets are optional. 

{ item | 
item } 

Indicates to select only one of the items listed between braces. A vertical bar ( | ) separates 
the items. 

... (ellipses) Indicates that you can repeat the preceding item. 
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2 Overview 
Intel® SoC Watch is a command line tool for monitoring system behaviors related to power 
consumption on Intel® architecture-based platforms. It monitors power states, frequencies, bus activity, 
wakeups, and various other metrics that provide insight into the system’s energy efficiency.  

To collect and analyze power data:  

1. Collect data. A summary (CSV) file and raw data (SW1) file are produced by default on the target 
system (which is the system being analyzed).  

2. Optionally, import the raw data into the Intel® Energy Profiler (via Intel® VTune™ Amplifier for 
Systems) tool on the host system (which is the system where VTune Amplifier for Systems is 
installed) to correlate and visualize the system behavior over time. Utilize powerful filtering in 
VTune Amplifier for Systems to analyze the results.  

3. Optionally, collect a timed trace (CSV) file that can be opened by Microsoft* Excel* and graph the 
individual metrics overtime.  

4. Optionally, post-process the SW1 file to generate a raw trace (TXT) file. 

Figure 1: Collecting SoC Watch Data and Generating Output Files 
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2.1 Requirements 
Intel® SoC Watch for Android works on systems based on the following platforms: 

• Next-Generation 22nm Intel® Atom™ Processor-based SoC for Tablets and 2-in-1s (formerly 
code named Bay Trail)  

• Next-generation 22nm quad-core Intel® Atom™ SoC for tablets (formerly code named 
Merrifield). 

• 4th generation Intel Core processor-based Ultrabook (formerly code named Harris Beach),  
• Intel® Atom™ Processor Z35XX (formerly code named Moorefield). 
• Intel platforms code named Cherry Trail 

See the socwatch.intel.com wiki for detailed system requirements. 

2.2 Building the Kernel Modules  
If the SoC Watch device drivers are not preinstalled in the OS image, you will need to build them.  

1. Copy the socwatch_android_XXX.zip file to the host system used to build the target system’s 
Android* kernel. 

2. Extract the contents with the command: 
> tar xvzf socwatch_android_XXX.zip 

The socwatch_android_XXX directory is created.  

3. cd into the socwatch_android_XXX/soc_perf_driver/src directory.  
4. Execute the build-driver script with the command: 

 > sh ./build-driver  

5. If the build fails due to the asm/intel_mid_pcihelpers.h file missing, remove the following 
line from the soc_perf_driver/src/Makefile 
 EXTRA_CFLAGS += -DCPI_HELPERS_API  

6. cd into the socwatch_android/socwatch_driver/lx_kernel directory.  
7. Execute the build_driver script with the command: 

 > sh ./build_driver –k <kernel-build-dir>  

where <kernel-build-dir> is replaced with the local Android* lib/modules directory produced 
while building the Android* kernel. The –k switch is optional and is not required if the 
DEFAULT_KERNEL_BUILD_DIR value is properly set in the build_driver script.  

a. If the following error occurs while building the SoCWatch driver, use the –s | --symvers 
switch to enable the build to find the socperf driver’s Module.symvers file. 

WARNING: "SOCPERF_Read_Data" undefined! 

b. The full path to the socperf driver’s Module.symvers file is passed as a parameter to the –s 
switch. For example,  
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sh ./build_driver –k <kernel-build-dir> -s /mydir/ 
socwatch_android_XXX/soc_perf_driver/src/Module.symvers 

2.3 Installation 
The Intel® SoC Watch device drivers are integrated into several Android* distributions based on Intel® 
Architecture. Note that the socwatch executable files are not integrated into the distribution and need 
to be installed with the socwatch_android_install script or BAT files. Before installing the socwatch 
executable files, make sure the appropriate drivers are installed and the socwatch driver version 
matches the version of the executable to be installed. For Intel® SoC Watch v1.5, the SOCWATCH1_5.ko 
file should be installed. You can check the existence of the SOCWATCH1_5.ko driver with the following 
commands; 

• adb shell ls /lib/modules/SOCWATCH1_5.ko 
• adb shell ls /system//lib/modules/SOCWATCH1_5.ko 

If the driver is not available on the system, you will need to build it. See the Building the Kernel Modules 
section. 

Make sure the host is connected to the target via adb before running the install script. 

1. After unzipping the Intel® SoC Watch package on your host system, run the 
socwatch_android_install.sh script on a Linux host or from a Cygwin window on a Windows 
host. Run the socwatch_android_install.bat file from a Windows host. 
> socwatch_android_install.sh or socwatch_android_install.bat 

The script installs the Intel® SoC Watch executables to the /data/socwatch directory on the 
target by default. Use the –d option to select a different install directory and the –s option to define 
a specific Android* device if multiple devices are connected to the host via adb.  

2. Using the adb command, start a shell with root privileges.  
> adb root 
> adb shell 

3. Navigate to the directory containing the driver.  
> cd /lib/modules 

4. Load the drivers. Note that the socperf driver must be loaded before the socwatch driver.  
> insmod socperf1_2.ko  

NOTE: Make sure to use the latest version of the socperf driver  
> insmod SOCWATCH1_5.ko 

5. Confirm the driver is loaded.  
> lsmod  

When necessary, type rmmod socperf1_2 and rmmod SOCWATCH1_5 to unload the drivers. The 
SOCWATCH driver must be unloaded before the socperf driver is unloaded. 
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2.4 Quick Start 
The following steps assume the Intel® SoC Watch driver and executables are installed. See the 
Installation section above for instructions on how to install Intel® SoC Watch.  

Use the following steps, targeted for an Ubuntu*-based host,  to quickly collect processor C-state and 
P-state data for 60 seconds on an Android-based system and import it into VTune Amplifier for 
Systems for analysis.  

1. On the host system, establish a root adb shell on the target.  
> adb root 

> adb shell 

2. Load the device drivers. Note that the socperf driver must be loaded before the socwatch driver.  
> insmod /lib/modules/socperf1_2.ko 

NOTE: the latest version of the socperf driver should be used 
> insmod /lib/modules/SOCWATCH1_5.ko 

3. Confirm the driver is loaded.  
> lsmod 

Confirm the Intel® SoC Watch drivers (socperf1_2 and SOCWATCH1_5) are included in the list of 
installed modules. 

4. Setup the collection environment. This step assumes the default install directory was used.  
> cd /data/socwatch 
> . ./setup_socwatch_env.sh 

5. Collect data and generate the test.csv and test.sw1 files in the results directory. This step 
assumes the /data/socwatch/result directory exists. 
>./socwatch –-max-detail –f cpu-cstate –f cpu-pstate –t 60 –o 
./results/test 

6. Exit the adb shell.  
> exit 

7. Use adb to pull the result files to the host.  
> adb pull /data/socwatch/results/test.csv /results 
> adb pull /data/socwatch/results/test.sw1 /results 

8. Review the summary. Open the /results/test.csv file. 
9. Import the data into VTune Amplifier: 

Open a command prompt. Note that file write permissions are required for the working directory. 
Specify the full path to the VTune Amplifier for Systems amplxe-runss executable and enter: 
> ”<VTune Amplifier installation folder>/bin32/amplxe-runss.exe” –import-
socwatch-data /results/test.sw1 –r /results/test 

This command creates the /results/test directory. The test.amplxe file is created along with 
additional files and directories. To avoid specifying the whole path, execute the amplxe-vars.bat 
or amplxe-vars.sh file in the VTune installation directory. 

10. Navigate to the VTune Amplifier bin32 or bin64 directory and start the VTune Amplifier GUI.  
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> amplxe-gui 

11. Open the result by selecting: File -> Open -> Result… and navigating to the 
/results/test/test.amplxe file. Click Open. 

12. Click on the Viewpoint selection drop-down (change) link and select the Platform Power Analysis 
viewpoint to view and analyze the data. 

 
To collect additional data, see the Using Intel® SoC Watch section below. To graph the data 
collected in Microsoft* Excel*, see the Graphing Timed Trace Data with Microsoft* Excel* section 
below. 

Table 2: Key Files 

socwatch_android_install.sh The Linux install script. It creates a /data/socwatch directory on 
the target system and copies the necessary files there via the adb 
push shell command. 

socwatch_android_install.bat The Windows install script. It creates a /data/socwatch 
directory on the target system and copies the necessary files there 
via the adb push shell command. 

soc_perf_driver/src/build-driver The build script used to build the socperf device driver for Android* 
systems. 

/lib/modules/socperf1_2.ko The socperf kernel module used to measure bandwidth and DRAM 
self refresh.  

socwatch_driver/lx_kernel/build_driver The build script used to build the Intel® SoC Watch device driver for 
Android* systems. 

/lib/modules/SOCWATCH1_5.ko The Intel® SoC Watch kernel module used to collect both hardware 
and kernel data at runtime. 

setup_socwatch_env.sh The script used to setup the Intel® SoC Watch runtime 
environment. 

socwatch The Intel® SoC Watch executable built as a native Android* 
application. Use this file on Android* systems to collect data and 
generate additional results from a raw SW1 file. 

SOCWatchConfig.txt The Intel® SoC Watch configuration file. The configuration file is 
read by Intel® SoC Watch immediately before each collection. It 
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contains hardware addresses utilized by the device driver during 
the collection. 

EULA.txt End User License Agreement file. 
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3 Using Intel® SoC Watch 
NOTE: Intel® SoC Watch does not collect any data by default. You must specify what data 

you wish to collect with the –f switch. 

Before starting a collection, source the setup_socwatch_env.sh script to set the necessary 
environment variables. 

NOTE: The first . character followed by a space must be specified in order to set the 
environment variables for the shell. Failure to include the initial character (period) will 
cause the Intel® SoC Watch execution step to fail. 

. ./setup_socwatch_env.sh 

To launch a collection, type  
./socwatch <general options> <collection options> <post-processing 
options> 

3.1 General Options 
-c, --config-file <config_file_name>:  

Specify the configuration file. The <config_file_name> argument can optionally include an 
absolute or relative path. Intel® SoC Watch loads architecture information from a configuration file, for 
example, MSR address information. If this switch is not specified, Intel® SoC Watch loads the default 
configuration file SoCWatchConfig.txt. 

-d, --debug:  

Generate debug output from Intel® SoC Watch. Used to debug Intel® SoC Watch collection and 
processing issues.  

-h, --help:  

Display usage information and exit. 
-v, --version:  

Print Intel® SoC Watch and device driver information and exit. 

3.2 Collection Options 
-f, --feature <data_to_collect>:  

Specify the data to be collected. See the Available Features section below. Each data_to_collect 
needs to be prefaced with a -f or --feature switch. For example, -f cpu-cstate will cause Intel® 
SoC Watch to collect processor C-state data and –f cpu-cstate –f cpu-pstate will cause Intel® 
SoC Watch to collect both processor C-state and processor P-state data. The –m, --max-detail 
switch determines what collection mechanism is used. See below.  
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-m, --max-detail:  

Specify the level of detail to collect. This switch applies to all data specified to be collected by the –f 
switch. Internally, this switch setting guides the tool’s choice of a collection mechanism and also 
controls overhead. In general, if -m is specified, the tool will collect the maximum detail possible and 
may also cause the highest overhead. In general, if -m is not specified, the tool will collect a minimum 
amount of detail and may also cause the minimum overhead. 

Intel® SoC Watch uses different methods to collect data to provide the maximum detail or minimum 
overhead. Data may be traced, polled, or snapshot to give you the most accurate result or an acceptable 
result with minimum system perturbation. Traced data is read when the metric itself changes providing 
the most accurate result. Polled data is read at regular intervals. Note that polled data may not be 100% 
accurate as metric changes that take place between polling intervals will not be measured. Snapshot 
data is read at the beginning and end of the collection and the difference is provided in the result. 
Snapshot data provides the average result, minimum overhead, and the least amount of detail. The 
following algorithm used to determine the collection method for each data type is as follows: 

If –m is specified;  

   if the data can be traced, trace it; 

   else if the data can be polled, poll it; 

   else snapshot it. 

If –m is not specified; 

   if the data can be snapshot, snapshot it; 

   else if the data can be traced, trace it; 

   else poll it. 
-n, --interval <milliseconds>:  

Specify the polling interval used when data is polled. The default polling interval is 100ms. The 
minimum polling interval is 30ms. 

-o, --output <file_name>:  

Specify an output file name (optionally including path). Collected data (if any) is written to the file 
file_name.csv and file_name.sw1. If the –o switch is not specified, data is saved to the 
SoCWatchOutput.csv and SoCWatchOutput.sw1 files in the current directory. To create additional 
files, use the –r switch described below. 

-p, --program <application><parameters>:  

Specify the application (including path to the executable)  and its parameters to be launched by Intel® 
SoC Watch at the same time a collection is started.  

NOTE: The –p switch MUST be the last Intel® SoC Watch switch used on the command line. 
r, --result <result_type>:  

Specify the type of results to be generated. Two types are possible: int and raw. The int option 
generates a timed trace CSV file for each data type collected (specified by the –f switch). This switch 
must be used during a collection. If the –r raw switch is used in conjunction with the –m switch, a raw 
trace TXT file will be generated. Each result file to be generated must be prefaced with the –r switch. 
Only traced or polled data can generate an int or raw result. 
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-s, --startdelay <seconds>:  

Specify the collection delay in seconds. Data capture starts seconds after the Intel® SoC Watch 
command is executed. 

-t, --time <seconds>:  

Specify the duration of the collection, in seconds. Intel® SoC Watch stops a collection when any of the 
following three events occur:  

• the duration specified by the –t switch has elapsed 
• Intel® SoC Watch receives a SIGINT (CTRL-C) 
• the application launched by Intel® SoC Watch with the –p switch exits 

3.2.1 Available Features 
The available data types that Intel® SoC Watch can collect and their possible collection methods are 
listed below. Detailed descriptions of the different kinds of data are provided in the Data Type 
Descriptions section below.  

cpu-cstate 
Collection Method(s): trace, snapshot 

Collect Intel® architecture core, module, and package C-state data using hardware C-state residency 
MSR data and the wakeups that cause Intel® architecture cores to exit a C-state. Note that wakeups are 
only collected if the –m switch is specified. 

cpu-pstate  
Collection Method(s): trace 

Collect Intel® architecture core P-state (frequency) data using hardware MSR data. 

s0i-state, acpi-sstate 
Collection Method(s): snapshot, trace (respectively) 

If the s0i-state or acpi-sstate feature is specified, both S0ix and ACPI Suspend-To-RAM (S3) 
data will be collected concurrently. S3 data is traced using kernel hooks to trace the system’s S3 
behavior. S0ix data is snapshot at the start of the collection, at the end of the collection, and during S0-
>S3 and S3->S0 transitions.  

On Next-generation 22nm quad-core Intel® Atom™ SoC for tablets (formerly code named Merrifield) and 
Intel® Atom™ Processor Z35XX (formerly code named Moorefield) platforms, Intel® SoC Watch issues 
IPC commands to the SCU to read S0ix counters.  

On the Next-Generation 22nm Intel® Atom™ Processor-based SoC for Tablets and 2-in-1s (formerly 
code named Bay Trail) and Cherry Trail platforms, Intel® SoC Watch reads counters in the PMC block’s 
PCI address.  

nc-dstate 
Collection Method(s): poll 

Collect North Complex component D0ix data via PCI reads.  
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sc-dstate 
Collection Method(s): snapshot 

Collect South Complex component D0ix data. This is supported on these platforms: 

• Next-generation 22nm quad-core Intel® Atom™ SoC for tablets (formerly code named 
Merrifield)  

• Intel® Atom™ Processor Z35XX (formerly code named Moorefield) platforms.   

Intel® SoC Watch issues IPC commands to the SCU to read D0ix counters. 

core-temp 
Collection Method(s): poll 

Collect Intel® architecture core temperature data via MSR reads. 

pmic-temp 
Collection Method(s): poll 

Collect MSIC/PMIC temperature data via sysfs reads. 

skin-temp 
Collection Method(s): poll 

Collect device skin temperature data via sysfs reads. 

soc-temp 
Collection Method(s): poll 

Collect SoC temperature data via PCI reads. 

gfx-pstate 
Collection Method(s): poll  

Collect GPU P-state (frequency) data. 

gfx-cstate 
Collection Method(s): poll  

Collect GPU C-state data. This data type can only be collected on Next-Generation 22nm Intel® Atom™ 
Processor-based SoC for Tablets and 2-in-1s (formerly code named Bay Trail) and Cherry Trail 
platforms. 

NOTE: Some bandwidth measurements include ReadPartial or WritePartial traffic. The payload 
(how many bytes were transferred) of a partial transaction can range from 1 to 64 
bytes. Therefore, the exact bandwidth cannot be accurately measured. In these 
cases, the Intel® SoC Watch bandwidth results will provide a Total Bandwidth Range. 
The Total Bandwidth Range describes the minimum or maximum bandwidth that was 
measured. The actual bandwidth falls within the Total Bandwidth Range. 
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ddr-bw 
Collection Method(s): poll  

Measure total DDR bandwidth in MB/sec. Note that only one bandwidth or DRAM Self Refresh data type 
can be specified at a time. 

cpu-ddr-bw 
Collection Method(s): poll  

Measure the IA Core to DDR bandwidth in MB/sec. Note that only one bandwidth or DRAM Self Refresh 
data type can be specified at a time. 

io-bw 
Collection Method(s): poll  

Measure the bandwidth between the North Cluster (NC) and South Cluster (SC) in MB/sec. Note that 
only one bandwidth or DRAM Self Refresh data type can be specified at a time. 

disp-ddr-bw 
Collection Method(s): poll  

Measure the display controller to DDR bandwidth in MB/sec. Note that only one bandwidth or DRAM 
Self Refresh data type can be specified at a time. 

gfx-ddr-bw 
Collection Method(s): poll  

Measure the graphics component to DDR bandwidth in MB/sec. Note that only one bandwidth or DRAM 
Self Refresh data type can be specified at a time. 

isp-ddr-bw 
Collection Method(s): poll  

Measure the ISP (camera image processor) to DDR bandwidth in MB/sec. Note that only one bandwidth 
or DRAM Self Refresh data type can be specified at a time. 

all-approx-bw 
Collection Method(s): poll  

Estimate multiple SoC bandwidths concurrently. SoC transactions are counted and multiplied by 64 to 
estimate multiple SoC bandwidths concurrently. The estimates will be equal to or higher than the actual 
SoC bandwidths. If the transactions executed during a collection include partial or 32 byte transfers, the 
estimate will be high.  

On Next-Generation 22nm Intel® Atom™ Processor-based SoC for Tablets and 2-in-1s (formerly code 
named Bay Trail), this feature provides the following estimated bandwidths: 

• Module 0 and Module 1: the bandwidth from CPU Module 0 and Module 1 to the DDR 
• GFX: the bandwidth from the graphics component to the DDR 
• Display: the bandwidth from the display controller to the DDR 
• ISP: the bandwidth from the camera image processor to the DDR 
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• VED: the bandwidth from the video encode and decode components to the DDR 
• IO: the bandwidth between the north and south clusters 

On systems code named Cherry Trail, and Intel® Atom™ Processor Z35XX (formerly code named 
Moorefield), this feature provides the following estimated bandwidths: 

• Module 0 and Module 1: the bandwidth from CPU Module 0 and Module 1 to the DDR 
• GFX: the bandwidth from the graphics component to the DDR 
• Display: the bandwidth from the display controller to the DDR 
• ISP: the bandwidth from the camera image processor to the DDR 
• IO: the bandwidth between the north and south clusters 

On Next-generation 22nm quad-core Intel® Atom™ SoC for tablets (formerly code named Merrifield) 
platforms, this feature provides the following estimated bandwidths: 

• Module 0: the bandwidth from CPU Module 0 to the DDR 
• Display: the bandwidth from the display controller to the DDR 
• GFX: the bandwidth from the graphics component to the DDR 
• ISP: the bandwidth from the camera image processor to the DDR 
• IO: the bandwidth between the north and south clusters 

dram-srr 
Collection Method(s): poll  

Measure the residency of DRAM while it is in self refresh mode. Note that only one bandwidth or DRAM 
Self Refresh data type can be specified at a time. 

3.2.2 Combination Features 
The following features are combinations of the previously described features. These features can be 
used to simplify command lines used to collect multiple data types concurrently. For example, the –f 
cpu switch can replace the –f cpu-cstate –f cpu-pstate switches in a command line.  

 

If a combination feature includes a feature not supported on the target platform, that feature will be 
ignored. For example, if the device switch is utilized on a Next-Generation 22nm Intel® Atom™ 
Processor-based SoC for Tablets and 2-in-1s (formerly code named Bay Trail) system, the sc-dstate 
feature, normally included in the device feature, will be ignored. 

cpu 
A combination of the cpu-cstate and cpu-pstate features. 

device 
A combination of the nc-dstate and sc-dstate features. 

gfx 
A combination of the gfx-cstate and gfx-pstate features. 
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sys 
A combination of the cpu-cstate, cpu-pstate, s0i-state, acpi-sstate, nc-dstate, sc-
dstate, core-temp, soc-temp, skin-temp, pmic-temp, gfx-cstate, gfx-pstate, and ddr-bw 
features. 

temp 
A combination of the core-temp, soc-temp, skin-temp, and pmic-temp features. 

3.3 Post-Processing Options 
-i, --input <file_name>:  

Specify an input SW1 file to post-process. Use this switch in combination with the –r raw switch to 
generate a file_name.txt raw trace result.  

-r, --result <result_type>:  

Specify the type of results to be generated. One type is possible: raw. The raw option generates a raw 
trace TXT file. In order to generate a TXT file with the –r raw switch, the SW1 file must be generated 
with the –m switch. Only traced or polled data can generate a raw result. 

The –o switch can be used to define the output name of the TXT file generated with the –i –r raw 
switch combination. If the –o switch is not specified, the TXT file will be named SoCWatchOutput.txt 
and placed in the working directory. 

3.4 Examples 
./socwatch –f cpu-cstate –t 10 

Collect processor C-state information with minimum overhead and detail – snapshot C-state data for 10 
seconds. Generate the SoCWatchOutput.csv summary result file and the SoCWatchOutput.sw1 file.  

NOTE: A result with snapshot only data cannot be post processed or imported into VTune 
Amplifier for Systems. 

./socwatch --max-detail –f cpu-cstate –t 10 

Collect processor C-state information with maximum detail – trace C-state data for 10 seconds. 
Generate the SoCWatchOutput.csv summary result file and the SoCWatchOutput.sw1 file that can 
be post-processed or imported into VTune Amplifier for Systems. 

./socwatch –i SoCWatchOutput.sw1 -r raw  

Use the SoCWatchOutput.sw1 file collected earlier to generate the SoCWatchOutput.txt raw trace 
file.  

./socwatch --max-detail –f cpu-cstate –f cpu-pstate –f core-temp –t 120 

Collect processor C-state, processor P-state, and core temperature information with minimum 
overhead and detail for 120 seconds. Polled data, core-temp data in this case, will be read at a 100ms 
(default) interval. Generate the SoCWatchOutput.csv summary result file and the 
SoCWatchOutput.sw1 file that can be post processed or imported into VTune Amplifier for Systems.  



 
Using Intel® SoC Watch 

User Guide    19 

./socwatch –f cpu-cstate –f core-temp –n 1000 –t 30 –o ./result/test1 

Collect processor C-state and core temperature information with minimum overhead and detail for 30 
seconds. Polled data will be read at a 1000ms (1 second) interval. Generate the result/test1.csv 
summary result file and the result/test1.sw1 file that can be post processed or imported into 
VTune Amplifier for Systems.  
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4 Intel® SoC Watch Output Files 
Intel® SoC Watch generates two files by default after every collection including a summary CSV file and 
a raw data SW1 file. Intel® SoC Watch can optionally generate timed trace CSV files for each feature 
(data type) collected and a raw trace TXT file. 

Table 3: Intel SoC Watch Output Files 

Output File Type Description 

Summary CSV File The summary CSV file provides an overall summary of the data 
collected for each feature (data type) specified with the –f switch. 

Raw Data SW1 File The raw data SW1 file captures the raw results of the collection in a 
binary format. The SW1 file can be imported and visualized with VTune 
Amplifier for Systems. 

Timed Trace CSV Files A timed trace CSV file for each feature (data type) collected can be 
optionally generated with the –r int switch. For example, a timed 
trace CSV file can be generated that describes the processor C-state 
results on a per second basis. The resulting file can be imported into 
Microsoft* Excel* to be graphed. 

Raw Trace Text File A raw trace TXT file can be optionally generated with the –r raw 
switch. 
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5 Data Type Descriptions 
The following section describes the different data types that can be collected by Intel® SoC Watch. Each 
subsection’s title corresponds to the –f switch used to collect a particular data type. 

cpu-cstate 
The –f cpu-cstate switch measures Intel® architecture core C-states. C-states are core power states 
used to minimize the core’s power consumption when the core is not actively executing instructions. C-
states range from C0 to Cn (for example, C6). C0 is the power state where the core is actively executing 
instructions. Deeper C-states (for example, C1, C2, and others) consume less power than C0 with Cn 
consuming the least amount of power. Each C-state deeper than C0 has a different enter and exit 
latency with the deeper C-states taking longer to enter and exit (return to C0).  

The operating system requests specific C-states using the mwait instruction. The processor may accept 
the request, select a different C-state based on its own status, or abort the C-state. See the Intel 64 and 
IA-32 Architectures Software Developer’s Manual at 
http://download.intel.com/products/processor/manual/253669.pdf for more information. 

cpu-pstate 
The –f cpu-pstate switch measures Intel® architecture core P-states. P-states represent voltage-
frequency control states defined as performance states in the industry standard Advanced 
Configuration and Power Interface (ACPI) specification. See http://www.acpi.info for more details. In 
voltage-frequency control, the voltage and clocks that drive circuits are increased or decreased in 
response to a workload. Also known as Dynamic Voltage and Scaling Frequency (DVFS), voltage-
frequency control leverages the equation P=a x Ceff x V2 x f that describes the power consumption of a 
CMOS circuit. P0 represents turbo mode where the processor can operate at a frequency higher than its 
nominal frequency depending on the state of the other cores, the current thermal headroom, and so on. 
P0 consumes the most power. P1 is the processor’s nominal frequency (advertised frequency), P2 is 
slower than P1, and so on. Pn consumes the least power.  

The operating system requests specific P-states based on the current workload. The processor may 
accept or reject the request and set the P-state based on its own state. Turbo mode is completely 
controlled by the hardware.  

NOTE: Operating the processor at the maximum P-state to finish the workload as quickly as 
possible and enter a deep C-state (known as Race to Halt) is often the most efficient 
power management strategy.  

s0i-state, acpi-sstate 
The –f s0i-state or –f acpi-state switch measures the residency in the Intel SoC idle standby 
power states and the system’s residency in the ACPI Suspend-To-RAM (S3) state. The S0ix states shut 

http://download.intel.com/products/processor/manual/253669.pdf
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off parts of the SoC when they are not in use. The S0ix states are triggered when specific conditions 
within the SoC have been achieved – for example, certain SoC components are in low power states. See 
http://landley.net/kdocs/ols/2012/ols2012-mansoor.pdf for a full description of the S0ix power states. 
The SoC consumes the least amount of power in the deepest (for example, S0i3) state. 

In the Suspend-To-RAM state, the Linux kernel powers down many of the systems' components while 
maintaining the system’s state in its main memory. The system consumes the least amount of power 
possible while in the Suspend-To-RAM state. Note that any wakelock currently held will prevent the 
system from entering the Suspend-To-RAM state. See the description of Suspend-To-RAM at 
http://www.linuxsymposium.org/archives/OLS/Reprints-2008/brown-reprint.pdf. 

nc-dstate 
The –f nc-dstate switch polls the SoC’s component power states for the north cluster components 
while the SoC is operating in the S0i0 state. D0ix power states ranges from D0i0 to D0i3, where D0i0 is 
fully powered on and D0i3 is primarily powered off.  

The SoC is organized into a north and south cluster where the compute intensive components (for 
example, video decode, image processing, and others) are located in the north cluster. The south cluster 
contains I/O, audio, system management, and other components. SoC components should be in the 
D0i3 state when not in use. 

sc-dstate 
The –f sc-dstate switch measures the SoC’s component power state residencies for the south 
cluster components. D0ix power states range from D0i0 to D0i3, where D0i0 is fully powered on and 
D0i3 is primarily powered off.   

NOTE: The –f sc-dstate switch only works on Next-generation 22nm quad-core Intel® 
Atom™ SoC for tablets (formerly code named Merrifield) and Intel® Atom™ Processor 
Z35XX (formerly code named Moorefield) platfroms. See 
http://landley.net/kdocs/ols/2012/ols2012-mansoor.pdf for a full description of the 
D0ix power states. 

core-temp 
The –f core-temp switch measures the temperature of each core during the collection. 
Understanding the core’s temperature is important as the core will throttle when it gets too hot. See the 
Intel 64 and IA-32 Architectures Software Developer’s Manual at 
http://download.intel.com/products/processor/manual/253669.pdf for more information. 

pmic-temp 
The –f pmic-temp switch measures the system’s Power Management Integrated Circuit’s 
temperature during the collection. Note that the PMIC is also called the Mixed Signal Integrated Circuit 
(MSIC). 

http://download.intel.com/products/processor/manual/253669.pdf
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skin-temp 
The –f skin-temp switch measures the system’s skin temperature during the collection. The 
temperatures are read from the sysfs. 

soc-temp 
The –f soc-temp switch measures the system’s SoC temperature during the collection. 

gfx-pstate 
The –f gfx-pstate switch polls the system’s GPU frequency during the collection. The 
measurements are reads of the GPU frequency at that point in time – i.e. gfx-pstate measurements do 
not measure the gfx-pstate since the last measurement and therefore should not be interpreted as 
100% accurate. The system can vary the GPU’s P-state during the collection in response to the graphics 
workload in an effort to minimize power consumption. 

gfx-cstate 
The –f gfx-cstate switch measures the system’s GPU power state residency during the collection. 
GPU power states range from Render C0 to C6 and Media C0 to C6. The C0 states indicate the GPU is 
fully powered on and operational while the C6 states indicate the GPU has been placed in the deepest 
power saving state available. Note that this data type can only be collected on Next-Generation 22nm 
Intel® Atom™ Processor-based SoC for Tablets and 2-in-1s (formerly code named Bay Trail) and Cherry 
Trail platforms) or platforms code named Cherry Trail. 

ddr-bw 
The –f ddr-bw switch measures the system’s total DDR bandwidth in MB/sec during the collection. 
The total DDR bandwidth includes all 32 byte and 64 byte read and write accesses to the memory from 
any component on the SoC including the cores, display, image processing, graphics, and south cluster 
components. Total DDR bandwidth activity indicates that the SoC is actively executing a workload and is 
a clue when trying to understand the system’s behavior when diagnosing system power consumption 
issues. Note that only one bandwidth or DRAM Self Refresh data type can be specified at a time. 

cpu-ddr-bw 
The –f cpu-ddr-bw switch measures the system’s CPU to DDR bandwidth in MB/sec during the 
collection. The CPU to DDR bandwidth includes all 32 byte and 64 byte read and write accesses to the 
memory from the CPU components in the north cluster. Note that only one bandwidth or DRAM Self 
Refresh data type can be specified at a time. 
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io-bw 
The –f io-bw switch measures the system’s bandwidth between the north and south cluster in 
MB/sec during the collection. Note that only one bandwidth or DRAM Self Refresh data type can be 
specified at a time. 

disp-ddr-bw 
The –f disp-ddr-bw switch measures the system’s display controller to DDR bandwidth in MB/sec 
during the collection. Note that only one bandwidth or DRAM Self Refresh data type can be specified at 
a time. 

gfx-ddr-bw 
The –f gfx-ddr-bw switch measures the system’s graphics component to DDR bandwidth in MB/sec 
during the collection. Note that only one bandwidth or DRAM Self Refresh data type can be specified at 
a time. 

isp-ddr-bw 
The –f isp-ddr-bw switch measures the system’s image processor to DDR bandwidth in MB/sec 
during the collection. Note that only one bandwidth or DRAM Self Refresh data type can be specified at 
a time. 

dram-srr 
The –f dram-srr, -f dram-srr-ch0, and –f dram-srr-ch1 switches measure the systems 
DRAM self refresh residency during the collection. The systems DRAM will enter a low power self 
refresh mode when it is not actively being utilized. DRAM self refresh residency should be high during 
idle workloads. Note that only one bandwidth or DRAM Self Refresh data type can be specified at a 
time.  
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6 Using VTune Amplifier for Systems to 
Analyze Intel® SoC Watch Data 
You can analyze Intel® SoC Watch data graphically using the VTune Amplifier for Systems GUI.  The GUI 
provides a dynamic timeline view for interacting with Intel® SoC Watch data and provides powerful 
filtering of data for in-depth analysis of a platform’s power management behavior.  

6.1 Importing Data 
To import data using VTune Amplifier for Systems, perform the following steps: 

 

1. Collect Intel® SoC Watch raw data (an SW1 file) as you normally would on your target system. You 
may specify any output file name, but these instructions are written assuming you use the default 
output file name SoCWatchOutput.sw1. 

2. Copy the raw data file back to the host development system: 
> adb pull /path/SoCWatchOutput.sw1  

3. Run the following command to create a VTune Amplifier project with the SoC Watch trace data: 
amplxe-cl –import <path_to_sww1_file> –result-dir <project_folder> 

where <project folder> is the result directory, for example, r001, or the full path to the result 
directory, for example, C:\Users\user_name\Documents\Amplifier for 
Systems\Projects\project_name\r001 

4. Launch the VTune Amplifier for Systems GUI: 

 Linux: /path-to-vtune/bin32(bin64)/amplxe-gui 
 Windows: Locate the VTune Amplifier for Systems in the Start menu. 

5. Click File > Open > Result… and then browse to your new result directory and select the .amplxe 
file. 
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6.2 Using the VTune Amplifier for Systems GUI 
Once the VTune Amplifier for Systems GUI is loaded, change to the Platform Power Analysis viewpoint. 

 
 

This viewpoint has a tab for each type of Intel® SoC Watch data collected.  All of the tabs have the same 
basic layout consisting of a timeline, grid and filter area.  These areas provide various mechanisms for 
manipulating and viewing the data. 

6.2.1 Filtering 
Each of the areas enables you to filter data to help focus the analysis on specific areas of the collection.  
Note that a filter from one part of the GUI affects the data shown in other parts of the GUI.  This 
includes data not only within a single tab, but also includes data shown in other tabs. 

The most common filtering is selecting a region of time to focus on.  To do this, use the timeline by 
selecting a region of time and selecting a filter action.  This restricts the data in the grid to only the data 
that was collected during the selected period of time. 

A common choice is the Zoom In and Filter In by Selection filter. This filter zooms the timeline and 
adjusts the grid to include only the data shown in the timeline (for example, the grid only includes the 
C-state residency or wakeups shown in the zoomed timeline). 

 
It is also possible to filter data using the grid by selecting rows of data, right-clicking to bring up the 
menu and selecting the filter action. 
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This filter then updates the timeline to show only the data associated with the selected rows in the grid.  
For example, this is useful when looking at data in the CPU Wake-up tab.  By filtering on the selected 
rows, you can see the behavior of just those wakeup sources in the timeline. 

Before filtering                 After filtering 

               
 The filter area behaves similar to the grid filter in action and is useful for quickly doing the most 
common and simple filtering actions. The filter area also has the button used to remove all the filters. 
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6.2.2 GUI Tips and Tricks 

6.2.2.1 Expanding Grid Columns 
The grid has an ability to expand certain columns of data to obtain more information.  If a column is 
expandable, you see a clickable >> symbol in the header of the column. Clicking on this symbol 
expands the column.  

              
 

Grid data can also be shown as raw values (for example, time in a specific C-state), percentages, or other 
representations. Right click on a value in the grid and select Show Data As and then select the desired 
representation. 

 

6.2.2.2 Changing Grid Groupings 
Certain tabs have grids that can show the data using multiple row hierarchies. Use the Grouping drop-
down box and select the desired grouping to change the row hierarchy. 
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6.2.2.3 Timeline Zooming 
Using the zoom functionality in the timeline makes it possible to do finer grain filtering and to examine 
individual discrete events.  For example, when zoomed out, this tooltip says that there are 96 wakeups 
at a given point.  By zooming in, it is possible to select each of these individual wakeups. 

 

                  
 

NOTE: The last sample shown in the VTune Amplifier timeline for polled data types (for 
example, temperatures and nc-dstate) is extrapolated from the previous sample. This 
is done to ensure that the timeline duration is the same for all metrics. 
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7 Graphing Timed Trace Data with 
Microsoft* Excel* 
Per metric, timed trace files (CSV files) generated with the –r int switch can be opened and graphed 
with Microsoft* Excel*.  

Follow these steps below to open and graph data in Microsoft* Excel*. The Trace_temperature-
socwatch_20.csv file is used in this example. 

1. Open the CSV file by double clicking on it. Select the data to be graphed.  

  
 

2. Select Insert > Line and then select a Line style. The data will be graphed overtime but the X-Axis 
will be incorrect. 
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3. Right click on the graph, select Select Data…, and click on the Edit button in the Horizontal 
(Category) Axis Labels field.  

 
 

4. The Axis Labels dialog box will pop up.  
5. Select the Cont Time data points that correlate with the data being graphed.  
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6. Finally, select OK on the Axis Labels dialog box and OK on the Select Data Source dialog box to 
finish graphing the data. 
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8 Intel® SoC Watch Tips 
If the collection needs to be performed untethered (that is, not connected to a host via a USB cable), 
use the nohup command with a start delay when launching Intel® SoC Watch and then disconnect the 
USB cable. The nohup command causes the terminal to ignore the hangup signal which would normally 
log the user out of the terminal when the USB cable is pulled. For example, use the following command 
to launch a 10 second collection after a start delay of 5 seconds. During the 5 second start delay, 
disconnect the USB cable from the device.  

> nohup ./socwatch –s 5 –f cpu-cstate –t 10 & 

Avoid using a CTRL-C via “adb” to terminate Intel® SoC Watch collections when running from Cygwin on 
a Windows host. Instead, use a timed collection (with the -t switch). Alternatively, use a Linux host. 

If you see C-state wakeups caused by timers with either the thread ID or the process ID set to -1, then 
double-check your kernel parameters: this sometimes occurs if the kernel was not compiled with the 
CONFIG_TIMER_STATS=y option. In addition, under certain (rare) conditions, it is possible to have a 
wakeup caused by a timer for which Intel® SoC Watch captures a thread ID but not a process ID. In this 
case, Intel® SoC Watch assigns the thread ID to the process ID, and the process name to Unknown-
Process-Name.  

8.1 IPI Wakeups 
Occasionally, interrupt, timer, workqueue execution, or sched_wakeup tracepoints do not occur before 
a core is placed again in a C-state. In other words, the C-state entry tracepoint occurs twice without an 
interrupt, timer, workqueue execution, or sched_wakeup tracepoint occurring in between. The 
associated wakeup may be caused by an IPI or Inter Processor Interrupt. IPIs are sent from one 
processor to another for different reasons1. Intel® SoC Watch monitors some per-CPU kernel IRQ 
statistics2 at the same time as the TSC, MPERF, and C-state residency MSRs are read. If the IPI counts 
increment during a C-state sample and an interrupt, timer, workqueue execution, or sched_wakeup 
tracepoint did not occur, the sample’s break type is set to IPI. Experiments were done with patched 
kernels3 to confirm the validity of this strategy. 

                                                                    
1 See http://en.wikipedia.org/wiki/Inter-processor_interrupt. 
2 See the irq_stat struct in the struct_irq_cpustat_t struct in the arch/x86/include/asm/hardirq.h file. 
3 See the smp_reschedule_interrupt and smp_call_function_interrupt functions in the arch/x86/kernel/smp.c file and 
the local_apic_timer_interrupt function in the arch/x86/kernel/apic/apic.c file. 
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Appendix A Acronyms and Definitions 
ACG:  Autonomous Clock Gating 

ACPI:  Advanced Configuration and Power Interface 

AON:  Always On 

DDR:  Double Data Rate SDRAM  

DVFS:  Dynamic Voltage Frequency Scaling 

FW:  Firmware 

LSS:  Logical SubSystem 

MSIC:  Mixed Signal Integrated Circuit 

MSR:  Model-Specific Register 

PMIC:  Power Management Intergrated Circuit 

PSI:  Platform and System Integration 

PSS:  Physical SubSystem 

SCU:  System Control Unit 

SDRAM: Synchronous Dynamic Random-Access Memory  

TSC:  Time Stamp Counter 
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